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 Adagio® Time&Billing 8.1C (2012.03.13) 

Release Notes  

The most up-to-date compatibility information is on the Product Compatibility Info link at www.softrak.com. 
 

 
Upgrade Complexity: 

 From prior version  Intermediate � 

Adagio 
DataCare 8.1A - 9.0A 
Crystal Reports® 8.5-B for Adagio 
ePrint 9.0A 
GridView 8.0A – 9.0D 
Lanpak 9.0D 
Ledger  9.0B – 9.0D 
ODBC 9.0A 
Payables 8.0A – 8.1D 
Receivables 9.0C (required) 
 (See Note 1) 

 
Other  

MS Office 2003, 2007 
MS Windows XP, Vista, 7 

Enhancements and revisions in Adagio Time&Billing 8.1C (2012.03.13) 

New Features 

♦ Installs the AdagioPDF printer driver. All reports and printouts from Adagio can be printed to the AdagioPDF printer to create a PDF 
document in the data folder. 

♦ Supports the features in Adagio ePrint. When ePrint is installed you can print reports to PDF files in configurable folders determined 
by the Report Type (General, Transaction or Audit). Receipts print to a separate, configurable Forms folder. Fields can be embedded 
to establish the file and folder names (User, Session Date, System Date, Time). Click the ePrint button (red "EP" icon) on any report 
dialog to print the report to PDF. The Paperless Reports option forces all reports to be printed to PDF. Reports can be printed to PDF 
and attached to an email (MAPI) with a single button click. 

♦ You can now have Time&Billing print an accounting copy of Bills to a PDF document to save you from printing and filing paper copies 
of the documents you send to customers. The Company Profile, Print Options tab, has fields called: 'Keep PDF Accounting copy?', 
and 'Bill accounting spec'. If Keep PDF Accounting copy is turned on, when printing Bills (except when printing from Billing History), 
Time&Billing will create accounting copies in a folder called Documents underneath the PDF Audit Reports Folder. It will do this 
regardless of whether you print to printer, file, PDF, fax, email, or screen. It will use the Bill accounting spec specified in the company 
profile for this purpose (not the spec selected on the print screen). The PDF file name is the Bill number. The conflict strategy for the 
accounting copy is to append _01,_ 02 etc. to the PDF document filename if you reprint it. 

♦ You can now have Time&Billing create a PDF archive of the customer copy of Bills you send to customers. The Company profile, 
Print Options tab, has the new option 'Archive PDF customer copy?'. If this option is turned on, when printing Bills, Time&Billing will 
create archive copies in the a folder called SOFTPDF under the data directory (not the Relative base folder, if it is set in Adagio 
ePrint). The PDF files are created regardless of whether you print to printer, file, PDF, fax, email, or screen. It will use the spec 
specified on the screen. The PDF files are named <customer number right justified and padded with “_” characters to fill to 6 
characters> followed by '_TB_' and the Bill number. The conflict strategy for the archive document is overwrite. 

♦ Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dialog to 
create a Favorite. Favorites for a report can be accessed from the report dialog in a drop-down field. Private Favorites are yellow, 
Public Favorites are blue. Added Favorite Reports and Print/Delete Favorites functions to the Reports menu. Multiple favorites can 
be defined for the same report. Favorites can be private to the Adagio user or public for use by all users. 

♦ Report Sets allow the grouping of Report Favorites into a single print job that will run unattended. Report Sets may be printed to 
printer or PDF files. Report Sets may be launched from a command file or a scheduled Windows task by running tbwin.exe with the 
parameter /R followed by the Report Set (ex. /RMonthEnd). A progress dialog lists the reports in the Report Set, the printing status of 
each, the destination folder, filename and conflict strategy. A log is generated that records the printing status of each report in the 
set. Use Report Sets to automate the printing of all your daily or month end reports. 

♦ Added User Preferences under the File menu. It allows you to set certain options by user that were previously global, including 
options previously found under File | Options, Reports | Report Options and the Company Profile. Includes new options 'On Start-up', 
'Alphabetically sorted field list' and 'Exclude Ranges'. The preferences can optionally be set for all users and preferences can be 
printed. If no individual user preferences have been set up for a user, all preferences originally set for the Adagio System 
Administrator, user SYS, will be used. 
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♦ You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature to 
display your company logo. Use the text strings to make the company name prominent on the desktop. Any JPG or other graphic 
image can be centered or stretched to fit on the main program desktop. These settings are made on the Appearance tab in the User 
Preferences function. 

♦ The option 'Auto-advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to be on the 
next row in the grid, allowing you to press F6, Enter and march through the found list. Turn it off if you usually want to search by a 
new criteria each time the smart finder is invoked. In either case the position is advanced in the grid each time the finder is opened. 

♦ The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you want field 
lists in the Column Editor and Filters fields sorted alphabetically. 

♦ Column Editor settings are now saved by grid by user by database. 

♦ New program icon and toolbar buttons provide a cleaner look and differentiate this new version visually. If you are installing an 
upgrade to 8.1D, to see the new icon you will need to edit the properties of any existing Time&Billing shortcuts, click the Change Icon 
button and select the new image. 

♦ Added Docket Styles and Filters to grids and finders in Time&Billing. 

♦ Account Styles were added in Ledger 9.0D. They are now supported in GL account finder grids in Time&Billing. 

♦ Customer Styles and Filters were added in Receivables 9.0B. They are now supported in customer grids and finders in Time&Billing. 

♦ Added a Find button the Edit Dockets function to allow you to look up Dockets by Customer Name or Phone Number, or by Docket 
Name, rather than having to determine or search for and enter their respective numbers. 

♦ The Edit Docket function allows you to sort the grid by Customer/Docket, Docket/Customer, Customer/Docket Name or Docket 
Name/Customer, whereas in previous versions you could sort by Customer or Docket. 

♦ Added the 'Active records only' option in the column editor for Docket grids and finders. 

♦ Added the 'Active records only' option in the column editor for Staff grids and finders. 

♦ Added a Find button to batch entry functions to allow you to look up customers by Name or Phone Number and Dockets by Name, 
rather than having to determine or search for and enter their respective numbers. 

♦ Added the 'Active records only' option in the column editor for the Customer, Docket, and Staff finders in batch entry. 

♦ On the Open database dialog you can now use Alt-B to open the browse and Alt-F (for Favorites) to open the previously opened list. 
In previous versions you had to use the mouse to select the folder buttons. 

♦ Alt-X now selects the Excel Direct button on grids where it is available. In previous versions you had to use the mouse to select Excel 
Direct. 

♦ The vitalEsafe upload progress dialog has been improved and the progress bar now accurately shows the percentage. It is no longer 
necessary to install the vitalEsafe patch. 

♦ The Adagio menu now includes the module from which it was selected to allow you to quickly open another instance of the same 
module. 

♦ Most Access Violation (AV) errors are now recorded by module in an exception log text file. The file is located in the program folder 
for each module. For example: \softrak\tbwin\tbwin.error.log or \softrak\ledger\ledger.error.log. When any Adagio module with a date 
in 2012 is installed the exception log is enabled for all other modules. An AV error is a generic error that can occur in Windows 
applications. This occurs when a program tries to access memory that cannot be addressed, which can happen for many reasons, 
including software or hardware/network problems. The address, program (EXE or DLL), form, and version information contained in 
the log will assist Softrak in tracing a problem if the address is located in the Adagio application code. 

♦ The System Status function can create a snapshot of detailed information about your Adagio installation and package it in a single 
zip file that can be sent to Softrak Technical Support or your Adagio dealer to assist them when answering questions or tracing 
problems. The information includes: Adagio install logs, program INI files and logs, system INI files and logs, directory listings of 
Adagio folders, versions and dates of all Adagio programs and system files. To create the snapshot zip file, select System Status in 
the Help menu, proceed when prompted and click the System Snapshot button at the top left of the Status of System screen. The zip 
file will be in the \softrak\system folder, located on the drive where Adagio is installed. The filename contains a date and time stamp, 
and is of the form AdagioSnapshotYYYYMMDD_HHMM.zip. The zip does not take any of your Adagio database files. 

♦ The Help | About screen has been redesigned and includes a link to documentation page for the module that shows New Features, 
What's New video and manuals. 



Adagio Time&Billing 8.1C     3 of 7 
TM20120313   08-Mar-2012 

♦ When Time&Billing is opened after installing an upgrade, a dialog is displayed with a link to a short video highlighting the new 
features. The dialog is displayed for each user until they tick 'Don't show this message again'. The video also be viewed anytime by 
visiting the Softrak website. Note: the dialog also appears when Adagio is installed at a new site. 

♦ The Adagio Data Source (ADS) writes to log files containing “last access” information about each workstation using Adagio, including 
the date, time, Adagio User ID, Windows User ID, Windows version and system settings. There is one log file per workstation, with a 
filename of <computer name>.log, containing one entry per Windows user who used Adagio. The log files are kept in the StationLogs 
subfolder, on the EZTasks path, typically \softrak\system\stationlogs. The log files are included in the System Status snapshot zip 
file. 

♦ The Shade Color for reports found in the Report Options tab in User Preferences now uses the full color pallet rather than just 8 solid 
colors. 

♦ Listing button added on the Group Setup window prints all options or enabled options only for a range of groups. 

♦ Optional Fields added to Dockets. Optional Fields function added to the File menu. Optional Fields are defined in the Company 
Profile. Support of Optional Fields in batch entry is planned for a future release. 

♦ Grids, filters, and finders now show the lookup values instead of the raw data values for typed fields. For example in Docket grids the 
Billing Level shows 'Source Code' or 'Docket' instead of 1 and 0. 

♦ Added new spec code C82 that combines the Customer Name 1 and Name 2 fields. 

♦ Added new specification codes D51 to D59 to print Optional Fields in Dockets on bills. 

♦ Pre-defined composite tables were added to 'Adagio Time&Billing 8.1C' dictionary for use when designing views in Adagio GridView:  
TB Hist Bill SubDetail /w Header+Detail 
TB Hist Detail /w Hist Header 
TB Hist Text /w Header/Detail 
TB Hist Time Text /w Hist Time 
TB WIP Text /w WIP 
TB WIP w/Docket 

Install Changes and Fixes 

♦ This version moves toward our goal of a more Windows 7 friendly environment for installation. If you are installing to a mapped 
network drive that is normally accessible, but you cannot see it during the install when attempting to select a drive or folder, you can 
now install by browsing to the correct folder using the Universal Naming Convention (UNC), for example \\myserver\accounting\. This 
avoids having to adjust the User Account Control settings, which requires you to restart your computer and temporarily grant 
Administrative privileges to the user if they are not an administrator. 

♦ This version simplifies installation by removing any consideration of the location of the Report Tables Drive (RTD) by the install and 
program in virtually all cases. Therefore the install no longer prompts for the RTD. 

♦ The install writes to the master install log file "AdagioMasterInstall.log" in the \softrak\system folder. An entry is written to this log 
when any full, upgrade or SP for any Adagio module (with a release date of March 2011 or later) is installed. It shows the version 
installed and the version being replaced, the name of the Windows user who did the install and the rights for that user. An entry is 
also written to the log when an updated version of the Adagio Data Source (ADS) is installed, showing the version installed and the 
version being replaced. This log can be used to quickly determine the install history for all Adagio programs. 

♦ When you select the 'Backup Files' option during an install, the replaced files are now saved in a subfolder named YYYYMMDD in 
the BACKUP folder, under the programs destination folder (rather than the BACKUP folder itself, where extensions need to be 
changed to .001, .002, etc. when there are multiple versions of the same file). 

♦ The install includes an option allowing you to skip creating entries under Windows Start for cases where you will be manually 
creating an icon for the user to start Adagio and do not want them starting from Windows Start. During the install, uncheck the option 
'Start Menu programs'. This avoids having to delete or change the Windows Start entry that would have been created. 

♦ The install no longer checks the Opportunistic Locking setting (Oplocks) on the workstation. 

♦ The Opportunistic Locking setting (Oplocks) on the workstation is no longer checked when the program is started. 

♦ The System Status function in the Help menu (chksys.exe) no longer prompts you to disable Oplocks. It displays the current Oplocks 
setting and allows you to change it. The 'Check R/W Status', 'Check Specific Folder' function now supports UNC browse, whereas 
before you would have had to turn UAC off to use it. 

♦ SetServerForAdagio and SetReportsTablesDrive utilities have been updated. The latter should virtually never be needed at an 
Adagio site once any Adagio module dated March 2011 or later has been installed. 
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♦ The install warns you if it finds reports in ModRP or CustomRP that may need to be adjusted for compatibility after install a 
Time&Billing upgrade. See the section Converting Custom Reports and Views in the Release Notes for more information. 

♦ When installing Adagio to a computer or server where no Adagio modules had previously been installed, if you installed an Adagio 
module that does not use the Crystal print engine first (such as Lanpak or GridView), when you installed FX you received the error 
"Adagio has been established on destination folder: [x:\SOFTRAK]. Yet the install cannot detect the corresponding Reports Tables..." 
and were unable to proceed. If the first module installed uses the Crystal print engine there was no problem. 

♦ The updated version of vitalEsafe no longer triggers a workstation install if it has already been installed by the workstation install for 
another Adagio module. This is also the case when installing Adagio for use with Remote Desktop Services (Terminal Services in 
Windows Server 2008 and previous versions). 

Problems Fixed 

♦ Billing Batch Listing report did not print the bill descriptions. 

♦ The Totals were incorrect on the Billing Action report Summary by Staff. 

♦ When entering a Time & Disbursement batch entry, if you entered the Docket first rather than the Customer, the Customer Type and 
thus the Rate were not loaded correctly in some cases. 

♦ Batches in the Billing and Time & Disbursement Batch Status reports were not cleared for generated batches (including error 
batches, which are generated). Thus the reports could not be completely cleared. 

♦ Tax was not calculated correctly on bills for Reverse Time for Tax Groups where tax is taxable, such as in Quebec. 

♦ The Find did not work correctly for selecting a customer with a leading zero in the Name field, such as for a numbered company. As 
result an order could not be created for the customer. 

♦ If your Ledger data was created with version 9.0x and you never used Ledger 8.1A or earlier versions, after printing the G/L 
Transactions report in Time&Billing, the Consolidate G/L Transactions dialog did not show the 2 options to consolidate by Fiscal 
Period. 

♦ When adding new customers the 'Billing Method' wasn't set to the default from the Company Profile. 

♦ When you create a Docket for an inactive Customer, a message asks if you want to make the Customer active. If you said No, the 
Docket was created anyway. The behavior now is that the Docket status is set to inactive, and you cannot make it active until the 
Customer is made active. You can continue to create the Docket, but clicking OK gives an error that the customer code is invalid if 
'Active records only' is set in the customer finder. If it is not set, then you can save the new Docket. 

♦ When the Customer is defined to ‘Bill by Docket’ and the report sorts by Customer, all the Bill headers from all bills except the first 
did not print on the Bill Batch Listing report, where bills are for the same customer. Depending on the number of pages for the report, 
the details either merged together or printed with column titles. 

♦ The 'Delete import file on success?' option in import templates was not saved with the template. If the option was set when the import 
was done the import file was still not deleted. 

♦ If after printing the Payroll Time Transaction report you elected to consolidate, there was an error and the transactions in the report 
were cleared instead of being consolidated. 

New Features and Problems Fixed in TimeKeeper 

♦ New program icon provides a cleaner look and differentiates this new version visually. If you are installing an upgrade to 8.1c, to see 
the new icon you will need to edit the properties of any existing TimeKeeper shortcuts, click the Change Icon button and select the 
new image. 

♦ Finders for Customer, Docket, and Staff support the Active setting. A warning is displayed if an in-active code is entered. Added the 
'Active records only' option in the column editor for Customer, Docket, and Staff finders. 

♦ Customer and Docket Styles are supported in finder grids in TimeKeeper. 

♦ The TimeKeeper install for remote use supports the new install scheme for a more Windows 7 friendly environment for installation 
and includes other improvements to the install. 

♦ Supports the 'Implied Decimal' option (set in User Preferences). 

♦ Finders now show the lookup values instead of the raw data values for typed fields. For example, in the Docket finder the Billing 
Level shows 'Source Code' or 'Docket' instead of 1 and 0. 

♦ The Remote Refresh function copies the Adagio common files (SD*) to allow support of Styles in finder grids on machines running 
TimeKeeper remotely. 
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♦ If the 'Always on top' option is enabled, when you right-clicked on a button to access the Timer info, and clicked the Delete button to 
remove it, the dialog that appears to ask the question to confirm deletion was underneath the Timer dialog. Depending on form 
positioning, the delete confirmation screen could have been completely hidden. 

Enhancements and revisions in earlier versions of Adagio Time&Billing 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

To install Adagio Time&Billing you need the serial number and install code from the download instructions email sent to you by Softrak 
Systems. 

If you are installing an upgrade, you need the serial number and install code from the upgrade download instructions email. A previous 
version of Adagio Time&Billing should already be installed on your computer before installing the upgrade. If a previous version is not 
already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter 
the serial number and install code from a previous version. 

Read the section ‘Upgrading to this Version’ below before installing an upgrade. 

If you are installing a Service Pack you do not need to enter a serial number or install code. However, a previous version of Adagio 
Time&Billing 8.1C must be installed before the Service Pack can be installed. 

To install Adagio Time&Billing (or an upgrade), run the program file you downloaded. Once the install program is running you can click 
the View button to open the Readme file for detailed instructions. If Adagio Time&Billing is installed on a network, you must also do a 
workstation install for each workstation running Adagio Time&Billing. Refer to “Installing on a network” in the Readme help for 
instructions. 

To install the Adagio Time&Billing Service Pack, run the Service Pack program and follow the instructions on the screen. After installing 
the Service Pack, a workstation install may be required at each station running Adagio Time&Billing. To determine if a workstation 
install is required, start Adagio Time&Billing at the workstation. The workstation install will be automatically started if required. Note: If 
you are updating multiple applications at the same time, it may be faster to run the all workstation install to update all applications at 
once on the station. Refer to “Installing on a Network” in the Readme for instructions. 

Note1: Adagio Time&Billing requires Adagio Receivables to run. Adagio Receivables must be version 9.0C (2012.02.24) or 
higher. 

Adagio Payables is optional. Adagio Payables must be version 8.0A or higher. 

Adagio Time&Billing 8.1C requires Adagio Lanpak (if used) to be version 9.0D or higher. 

Upgrading to 8.1C  Upgrade Complexity: Intermediate � 

Do not install this upgrade until you are certain you have the upgrades required above available to install. The upgrades to the 
other modules may be installed before or after installing the Time&Billing upgrade. 

Adagio Time&Billing 8.1C requires Adagio Lanpak (if used) to be version 9.0D or higher. If you require multiple users in Adagio 
Time&Billing or TimeKeeper, do not install this upgrade before you have installed Lanpak 9.0D or have it available to install. If 
you have any prior version Lanpaks installed but no 9.0D Lanpaks, the Adagio Time&Billing install will warn you. 

A database conversion is required. You can convert your database at any time. The program allows you to make a backup before 
proceeding with the conversion. The conversion from 8.1B should only take a few minutes. Once your database has been converted, it 
cannot be opened by earlier versions. You must convert your database by running Time&Billing 8.1C before running TimeKeeper 8.1C. 

You should perform a Data Integrity Check in your current version of before installing the new version and converting your database. 
Any errors should be rebuilt or dealt with in your current version to ensure a successful conversion. 

Remote users must install the TimeKeeper 8.1C upgrade on their remote computer. From the network drive where Adagio Time&Billing 
has been installed, run: \SOFTRAK\TBWIN\WKSETUP\TKSETUP.EXE. Immediately after installing TimeKeeper on the remote 
computer, you must run it and do a Refresh to update the data files to their 8.1C versions on the remote computer. 

Note: The Edit Customer function now uses a Lanpak license. If another user is already in AR this would require Adagio Lanpak to be 
installed. The View Customer function does not use a license, nor does viewing customers from within batch entry. 

Version 8.1C uses new program icons. To see the new icon you will need to edit the properties of any existing Time&Billing and 
TimeKeeper shortcuts, click the Change Icon button and select the new image. 
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Adagio Time&Billing 8.1C uses new the new Crystal Reports for Adagio table TBW81. Custom reports (CustomRP) may need to be 
updated to use the new table. You may also need to recreate some of the standard reports shipped with Adagio Time&Billing that you 
have modified (ModRP). 

GridView views originally created for Time&Billing 8.1B or earlier should be adjusted to use the 'Adagio Time&Billing 8.1C' dictionary 
(@B81C) to ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid 
the possibility of data corruption.  

Refer to the section 'Upgrading to 8.1C – converting custom reports and views' below for further details. 

If you have Adagio ePrint, the message "Do you want to turn on Allow PDF printing for this dataset, and enable PDF Printing for all 
users?" will be displayed the first time you open a database. Answer Yes to save having to manually enable PDF Printing for each user 
in the User Preferences function. 

Upgrading to 8.1C from versions earlier than 8.1B 

Adagio Time&Billing is not compatible with older versions of Adagio Receivables. Adagio Receivables must be version 9.0C 
(2012.02.24) or higher. 

The conversion to 8.1C could take a significant period of time on databases with a very large number of documents in the current 
WIP file across a network. For large databases, we recommend copying your database to a local machine, converting the data, and 
then copying it back. We strongly recommend you contact your dealer or consultant for assistance with this procedure and take a 
backup before proceeding. 

The Previously Opened database list is now saved by Adagio User rather than for all users. The first time an existing user or a new user 
logs into Adagio Time&Billing 8.1C they will be asked “Would you like your historical company access list set up?” Answer yes to have 
Time&Billing add all entries from the Previously Opened list from your prior version. It is no longer possible for all users to share the 
same Previously Opened list. 

The Import and Export Customer functions have been removed from Time&Billing. These same functions in AR support all the fields 
found on the Time&Billing tab in edit customer. Any custom Import and Export Customer templates in Time&Billing will have to be 
recreated in AR. 

If you have custom Crystal Reports for Adagio reports (CustomRP folder) or modified reports (ModRP folder) for Adagio Time&Billing 
that reference tables in Adagio Receivables and you are upgrading to AR from a version prior to 9.0A, you will have to adjust or 
recreate these reports to use the AR table ARW90. See the Adagio Receivables 9.0A Release Notes or Readme help for details. 
GridView views for Time&Billing tables that reference AR tables will also require adjustment to use the 'Adagio Receivables 9.0A-9.0C' 
table (@R90A). 

Old formats such as Lotus, Dbase and Clipper that are almost never used any more have been removed from import / export templates, 
leaving Excel, ASCII CSV (Delimited), ASCII Fixed Length and PSV Delimited. The old formats may be manually turned back on for 
sites that need them by editing \softrak\tbwin\tbwin.ini and adding section format lines as required: 

[Import/Export Formats] 
Lotus 123 ( Version 1.0 - 2.x)=1 
Lotus 123 ( Version 3.0 - 5.0)=1 
dBase III & IV=1 
FoxPro (all versions)=1 
Clipper (all versions)=1 
Symphony (Version 1.0,1.1)=1 
Quattro Pro (Version 1.0 - 6.0)=1 

Upgrading to 8.1C – converting custom reports and views 

Reports 

If you have modified any of the standard reports installed by Adagio Time&Billing, you will have to redo those modifications for 
Time&Billing 8.1C. Modified reports are files with an .rpt extension that you copied from \softrak\tbwin\StandardRP to 
\softrak\tbwin\ModRP and modified using Crystal Reports for Adagio. 

Custom reports created in Crystal Reports for Adagio for earlier versions of Time&Billing should be modified or recreated for use with 
Time&Billing 8.1C databases. Custom reports are files with an .rpt extension that you placed in softrak\tbwin\CustomRP. 

The main Crystal table for 8.1C is ‘TBW81’ and replaces 'TBW65'. The structure of the Dockets file was changed for 8.1C to add 
Optional Fields and Styles, and to support Find by Docket Name and Active dockets functions. Reports using the Dockets table must be 
adjusted or recreated to use the TBW81 Crystal table. The Dockets table shows as 'File Information' in the Crystal Reports Field 
Explorer (i.e. "Dockets" are called "Files" in the Crystal table). 
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There were other minor changes made for 8.1C but reports that do not reference Dockets will generally continue to work using the 
TBW65 table. However, it is recommended these reports so be changed to use the TBW81 table. You cannot create new reports using 
the old table and you cannot add new fields added for 8.1C using the old table. 

The ‘Installed only’ method of selecting tables for Adagio when defining reports in Crystal Reports for Adagio using ADAGIO.SSI to find 
your database is not supported for Time&Billing 8.1C. Find your database by the alternate method of searching for the Time&Billing 
company profile (global) file ‘TBGLOB’ instead. 

Views 

GridView views originally created for Time&Billing 8.1B or earlier should be adjusted to use the 'Adagio Time&Billing 8.1C' dictionary 
(@B81C) to ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid 
the possibility of data corruption. GridView 9.0A (2008.11.06) or higher has the ability to convert existing views when the dictionary 
changes with the release of an upgrade version of an Adagio module. 

GridView view files are located in the folder \softrak\tbwin\views if they are launched from the Inquires menu in Time&Billing but may 
also be located in other folders. 

The structure of the Dockets file was changed for 8.1C to add Optional Fields and Styles, and to support Find by Docket Name and 
Active dockets functions. The Active field was added to the Staff file. 

The GETEXTERNALDATA function added in GridView 9.0C (2010.10.01) allows you to create composite views without using tables 
from the composite dictionaries, such as 'Adagio {Composite Tables 9.0A}' (@Z90A), which are no longer required or maintained. Any 
views using the composite dictionaries should be updated to use the new function instead. 

-- end -- 


